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Description and Objectives

Course Description

The MicroStation CONNECT Edition features many updates and enhancements. These include the introduction of a 
ribbon-style graphical user interface (GUI), a new Backstage, relocation of the workspace settings such as Preferences 
and Configuration, updated tools and dialogs, Property Driven Annotation, a new Properties dialog replacing Element 
Information, Annotative Hatching, Display Rules to control the graphical display of elements, Drawing and Named 
Boundaries to help with sheet creation, Sheet Indexing to control sheet parameters, the attachment of non-graphical 
business data using Item Types, Reports that are generated from graphical and non-graphical data, Tables to control 
the display of text and numerical information, plus more!

This workbook contains a set of exercises that are used to become familiar with the features found in the MicroStation 
CONNECT Edition.

Skills Taught

 The Welcome Page

 WorkSpaces and WorkSets

 Branding a design file

 Navigating the ribbon interface

 Using the Backstage

 Property Driven Annotation

 Incorporating the Explorer

 Using Annotative Hatching

 Applying Display Rules

 Drawing and Named Boundaries

 Sheet Indexing



Copyright © 2016 Bentley Systems, Incorporated 3DO NOT DISTRIBUTE - Printing for student use is permitted

 Using the Reports tools

 Creating Tables

A Word About the WorkSpace...

Note that the exercises contained in this workbook are designed to use a custom WorkSpace, 
BentleyCONNECTTraining, and several example WorkSets from this WorkSpace.

The default installation folder for this dataset is:

C:\BentleyCONNECTTraining\WorkSets\

For more information on installing and configuring a training dataset for the MicroStation CONNECT Edition, please see 
the course:

Before You Begin: Configuring the Dataset for a MicroStation CONNECT Edition Course
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The Welcome Page

Staying current and being productive are both critical components in the successful implementation of a software 
application. The MicroStation CONNECT Edition offers several features to assist you in this endeavor. In this lesson we 
will launch the MicroStation CONNECT Edition, view the Welcome page, and access the WorkSpaces/WorkSets.

The skills learned in this lesson will include:

 Starting MicroStation CONNECT Edition

 Understanding the Welcome Page

 Accessing WorkSpaces/WorkSets in the Work Page

1. Start the MicroStation CONNECT Edition. Upon activation for the first time you will be taken to the Welcome page.
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The Welcome Page is only presented the first time the MicroStation CONNECT Edition is started. Each subsequent time MicroStation is 
activated, you will be taken directly into MicroStation with the Work Page displayed. 

Note: It is always possible to return to the Welcome Page using the arrow seen along the side of the application window.

The CONNECT Edition requires users to be “logged in” in order to run MicroStation. This login is used for various purposes such as 
tailoring the content of the Welcome page to the individual user as well as for CONNECTED Projects.

2. On the left side of the Welcome Page you will find VIEW EXAMPLES. VIEW EXAMPLES is a set of links to various example files (video and 
DGN files).

3. In the middle of the Welcome page you will find LEARNING. This area contains links to the latest training offerings hosted on the Bentley 
Learn Server that may be accessed to improve your skills with personalized learning. You can scroll up and down through the offerings 
shown or click the More Training button. Clicking either will open a web browser taking you to the Learn Server login where you can enter 
your Bentley Learn login credentials to access this training content.

4. On the right side of the Welcome Page you will see NEWS AND ANNOUNCEMENTS. This area contains RSS feeds. An RSS, or Rich 
Site Summary, is used to publish frequently updated information from news headlines, audio and video feeds, blog entries, and more.
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Here you will find feeds from various Bentley sites. The RSS feeds allow you to stay current with product news and innovations that 
improve productivity.

Clicking a link will open a window containing the link title, the publish date, and a hyper-link to open the page.

You may also use the arrows found on either the right or left sides of the window to scroll through the RSS feeds.

Clicking a hyper-link will open a web browser displaying the content of the RSS feed.

5. In the lower right corner of the Welcome Page you will find a set of buttons for the various Bentley social media pages.

Included are:

These buttons, when clicked, will open a browser taking you to the desired social media page or the Bentley Communities.

 Facebook  Twitter  LinkedIn

 The Bentley Communities  YouTube
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6. To begin working in MicroStation, place your cursor over the arrow on the right side of the application window. The arrow will expand.

Click Start a work session.

You will see the Welcome page slide to the right, displaying the new MicroStation CONNECT Edition Work Page. The Work Page 
provides access to the WorkSpaces/WorkSets, WorkSet Properties, and more.
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7. It is possible to return to the Welcome Page at any time. Place your cursor over the arrow on the left side of the window. This will expand, 
displaying Back to Welcome. Click Back to Welcome and the application window will roll back to the Welcome Page.

Return to the Work Page.

8. You can access help at any time by clicking the Question Mark ? in the upper right corner of the page.
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WorkSpaces and WorkSets

Bentley has long provided WorkSpaces to help configure MicroStation to meet the needs of your organization. A 
WorkSpace consisted of 5 levels of configuration including System, Application, Site, Project and User, with User and 
Project being selectable by the operator of the software. User, however was rarely used to represent a true user, and 
instead was typically employed as a filter for any variety of uses. It was also not uncommon for an organization to make 
use of multiple WorkSpaces.

The MicroStation CONNECT Edition is based upon the concept of WorkSpaces and WorkSets. This replaces the User 
and Project from earlier editions of MicroStation. A WorkSpace may be used to represent a Client, Facility, Department, 
Owner, or any desired organizational grouping based upon your specific needs. The WorkSpace then acts as a 
container for grouping WorkSets.

In this lesson you will:

 Access the Work Page

 Choose a WorkSpace/WorkSet

 Open a design file and model within a WorkSet

1. Start the MicroStation CONNECT Edition.

You are taken to the Start page. The Start page is built around the concept of WorkSpaces and WorkSets. Here you will have access to 
WorkSpaces and WorkSets, browse files, and open Help.

A WorkSpace is a container that is used to group WorkSets and may be used to represent any variety of things such as your client, your 
department, or a specific asset such as a plant or building.

A WorkSet is the replacement for the Projects found in previous versions of MicroStation and is used to represent a specific project within 
a WorkSpace.

Note: If this is the first Upon activation for the first time you will be taken to the Welcome page. Clicking the arrow on the right side 
of the Welcome page will take you to the Start page.

2. It is possible to open or create a new DGN without associating it to a WorkSpace/WorkSet.
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On the left side of the Start page, pick No WorkSet, and click Browse to open the file browser.

Navigate to the folder C:\BentleyCONNECTTraining\WorkSets\QuickStartforCONNECT\dgn and open Coordinates.dgn. The file is 
opened without being associated with a WorkSpace/WorkSet. WorkSpace/WorkSet.

This will open the design file with a minimal set of resources (fonts, line styles, etc.).

3. Click the File tab. You will be taken to the Backstage. Observe that the Recent Files list is being displayed for No WorkSet.

This is the list of recent files that have been opened without being associated with a WorkSpace/WorkSet.
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4. Close the active file.

5. Set the active WorkSpace to BentleyCONNECTTraining.

To open/change WorkSpaces, place the cursor over No WorkSpace, and click to open a window that will let you create a new WorkSpace 
or open an existing WorkSpace.

In the window, pick BentleyCONNECTTraining to select the BentleyCONNECTTraining WorkSpace.

The list of WorkSets that are associated with the BentleyCONNECTTraining WorkSpace is then available.
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6. From WorkSets, click the drop‐down arrow to view the WorkSets.

From here you can create a new WorkSet or choose an existing WorkSet.

7. Pick the WorkSet Example ‐ Plant.

You can now browse the files associated with the Example - Plant WorkSet.

8. Click Browse.

9. In the list of files, open BSI700‐D1100‐Equipment Details.dgn.

The Equipment Details design is opened and the default model is displayed. Note that this model does not contain any data. We wish to 
view the content of the model D-1101-001.
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10. Click the File tab and you will be taken to the Backstage View. From here it is possible to select the desired model within the design file. 
Pick Model and from the listing, select D‐1101‐001.

To open the model, click the file.

The model D-1101-001 is displayed.

Note: There are a number of ways to switch models. Selecting the model from Open is a new capability found in the MicroStation 
CONNECT Edition. There are additional new features found in Open that will be explored later.

11. We wish to view several additional drawings within the same WorkSet. Pick the File tab.
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12. From Open, click the Browse button.

When browsing, several useful features may be found in the Browse dialog:

These include file and folder history as well as WorkSpace/WorkSet selection.

Note: You can change the WorkSpace and/or WorkSet without closing the active file. This allows you to switch the active 
WorkSpace/WorkSets on the fly!
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Continue by opening each of the following models in turn:

13. Click the File tab. You are taken to the backstage view.

Observe the history that was created in the Recent Files list for the Plant WorkSet as the models were opened.

The list makes it easy to access files that you are actively working on within this WorkSet.

Take note of the Model that is listed for each one of these design files. This is the model that will be displayed when the design file is 
opened, not the last model accessed within the file. While you can choose the model to open from the drop-down menu, it may be more 
productive to set a specific model to make it easier to open with a single click.

To set the desired model for opening, you may do the following:

1. Open the file

2. Make the desired model the active model

3. Save Settings

File Name Model Description

BSI700-P1001-001-Pipe&SupportDetails.dgn P1001-001 Unloading Platform Piping

BSI700-S0501-Steel Details.dgn S0501-001 Unloading Platform Steel Details
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14. In the backstage view, change the display from details to thumbnails by clicking the Show Thumbnails icon.

This can make it easier to view the content of a file when browsing.

15. Change the display back to Details.

16. Close the active design file.
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Understanding the MicroStation CONNECT Interface

Do you find that you use a variety of applications when working on a design project? Have you or others in your 
organization had to face the challenge of learning the intricacies of using a new software package? Do you have a 
difficult time finding the right tool or understanding how to use it? If you find yourself answering YES to any of these 
questions, then the ribbon could have an important impact on you and your organization.

Often, when working on a design project, it is necessary to work with multiple applications and you may find yourself 
frequently switching between these applications throughout the day. Applications may include but are not limited to an 
e-mail client, office applications such as a word processor or a spreadsheet, and a CAD package such as MicroStation. 
Applications that use their own style of interface make it more inconvenient when switching because of their 
uniqueness. This presents difficulties in learning and staying current with a software package.

A fundamental knowledge of a user interface, the basic components, and how it functions is essential in being 
productive with any software package. This familiarity saves both time and money for an organization by making an 
application easier to adopt, use, and stay current with. It is for reasons such as these that the MicroStation CONNECT 
Edition has adopted a ribbon style interface.

This workbook contains a set of exercises to help you master the use of the ribbon in the MicroStation CONNECT 
Edition.

You will learn how to:

 Work with WorkSpaces and WorkSets

 Navigate the ribbon

 Use the Backstage
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Working with the Ribbon

MicroStation has used the same user interface for many versions, with the interface based upon Tasks. This has 
changed with the MicroStation CONNECT Edition delivering a brand new user experience. The task-based interface 
has been replaced with a ribbon style interface based upon “workflows” that incorporate many new tools and 
capabilities.

This modern, consistent and intuitive environment lowers the training threshold. The ribbon is an industry-standard 
layout for a user interface that is used by many applications, including Microsoft Office, and is comfortable to many 
users. This familiarity provides users with a more accessible user interface that is more productive and requires minimal 
training to adopt. Commands are logically grouped together in tool collections.

Customization is provided through custom ribbon tabs and groups with the ability to easily switch between interfaces on 
the fly.

In this lesson you will:

 Learn the parts of a ribbon

 Access the Backstage View

 Understand ribbon workflows, tabs and groups

 Discover the Quick Access tool bar

 Access settings integrated into the ribbon

1. Start the MicroStation CONNECT Edition.

2. Pick the following:

WorkSpace: BentleyCONNECTTraining

WorkSet: QuickStartforCONNECT
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3. Open Survey Topo 02.dgn.

If prompted, pick Use active WorkSet “QuickStartforCONNECT”, and click Open.

The ribbon interface is presented.
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Immediately the similarities between MicroStation and other applications that use a ribbon can clearly be seen:

Ribbon: Microsoft Word

Ribbon: MicroStation CONNECT Edition

Other improvements include:

Consistent Dialogs - Improves usability and productivity

 Consistent layout, spacing and organization

 Consistent resizing and layout rules

Updated User Interface Controls - Provides better visual feedback and improves navigation and accessibility

 Navigation

 Search (all commands, help, communities)

 Filter

Unified Properties

 The same properties dialog is used for file, element, etc.
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Let’s take a look at the parts of the ribbon!

The ribbon consists of the following components.

(Typical components of a ribbon‐style interface)

A knowledge of what these components are will be beneficial in your daily use of the MicroStation CONNECT Edition as well as for 
customizing the User Interface (UI).

We will look at various ribbon components in greater depth as we continue...
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4. Resizing Ribbon Groups

The the ribbon groups in the ribbon automatically resize as the application window is resized.

Observe the MicroStation user interface. In the image shown, the application window has been adjusted to its smallest size. Let’s pay 
particular attention to the Primary ribbon group.

In the illustration above, the icons contained in this group initially appear small because of the overall size of the MicroStation CONNECT 
application window.

If we resize MicroStation, the groups contained in the ribbon will resize as well.
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Place the cursor over the right edge of the MicroStation application window, press and hold the left mouse button, and begin dragging to 
resize the MicroStation applications window.

As you change the size of the application window, observe Primary Tools 

When the window is smaller, small icons will be seen. As the size increases, you will see larger icons and labels appear within the ribbon 
groups. This provides a cleaner, easier to use interface in the MicroStation CONNECT Edition

5. The Backstage

Open RD_Sheets.dgn.

The file we are currently working in was created from an older seed file and as such does not contain some of the properties (in the title 
block) that have now been standardized upon as a part of the plans production workflow in our company for the MicroStation CONNECT 
Edition.

We would like to add our company name, client name, and a keyword to the Properties of this DGN.

Pick the File tab.
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You are presented with the Backstage:

The Backstage contains many important features such as file operations, tools and settings, and more. This is also the location where you 
access file properties.

From the menu on the left side of the screen, pick Properties.

Note: The file properties now use the same Properties dialog as would reviewing an element from with within your design file.
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In Properties, make the following changes:

Client: FDOT

Title: University Boulevard

Subject: University Boulevard roadway widening

Keywords: University

These properties are then made available for use with Text Fields, Item Types, and reporting features.

Close Properties.

6. We wish to make it easy to exit a command by enabling the ESC key on the keyboard.

Click the File tab to open the Backstage View.

The backstage view is also the location where User, System, File and Configuration settings are accessed. By consolidating all of these 
features in the Backstage view, we help remove clutter from the design canvas.

In the backstage view pick Settings > User Settings. Here you will find AccuDraw Settings, the mouse Button Assignments and more.

Pick Preferences to open the Preferences dialog.
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In Preferences, locate the Input category and enable “ESC exits command”.

Click OK to implement this change. Pressing the ESC key on the keyboard will now exit most MicroStation Commands.

There are many other operations and settings that are available through the backstage view, such as Customize Ribbon to customize the 
ribbon and Quick Access toolbar.

Note: If you wish to close the backstage view and return to your design, you can click the arrow in the upper left corner of the 
Backstage or pressing the “Esc” key on the keyboard.

7. Ribbon Workflows

Pick the Ribbon Workflows drop-down menu. You can view the list of Ribbon Workflows. The Ribbon Workflows are used to group 
collections of tools into a logical “workflow”. A ribbon workflow may contain ribbon tabs, ribbon buttons, ribbon groups, and more.

The MicroStation CONNECT Edition delivers 5 individual ribbon workflows. These workflows are:

 Drawing

 Modeling

 Task Navigation

 Visualization

 Admin
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Click the drop-down arrow to view the available workflows:

 Drawing is available regardless of the active model that is open (2D, 3D, Design, Drawing or Sheet).

 The Modeling and Visualization workflows are only available when the active model is 3D.

 Task Navigation, when selected, makes the Select Task icon available. You may then use this icon to select from 3 delivered tasks 
when in a 2D model: Drawing, Drawing Composition and Terrain Model. If the active model is 3D, the available tasks consist of 
Drawing, Drawing Composition, Solids Modeling, Surface Modeling, Mesh Modeling, Terrain Model, Feature Modeling, 
Visualization and Animation. These are the equivalents of the Tasks from previous versions of MicroStation, but delivered in a 
ribbon style interface.

 The Admin workflow is made available when you open a configured DGNLib.

And remember, MicroStation also provides the ability to deliver a custom user experience by allowing you to create your own custom 
ribbon workflows.

In addition to the delivered workflows, you can also see a workflow entitled LEARNing CONNECT. This is an example of a custom 
workflow. This workflow is stored in a “configured” DGNLib that is part of our WorkSpace.

Take a moment to review the Learning CONNECT workflow.

Note: For more information on DGNLib’s, configuration files, and configuration variables consult your local CAD Support or IT 
Department.

8. The Quick Access toolbar

Continue in RD_Sheets.dgn.

The Quick Access toolbar is a small toolbar, located along the top edge of the MicroStation CONNECT interface, is used to access 
frequently used commands such as Save, Undo/Redo and Print.

These are commands that always need to be accessible regardless of what the active workflow is. And, like other areas within the 
interface, is also able to be customized.
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Zoom to the title block located in the lower right of the sheet similar to what is shown:

We wish to automatically view this area of the sheet the next time the drawing is opened.

From the Quick Access toolbar, pick Save Settings.

9. Change the active Workflow to Learning CONNECT.

The content of the ribbon has changed. It has updated to reflect the active workflow, but the Quick Access toolbar has remained as it was.

10. From the Quick Access toolbar, click the drop‐down arrow to reveal the list of tools.

The display of the available tools may toggled on/off from this menu.
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There are several tools that we do not require. Turn off the following tools:

 Save

 Set Mark

 Compress Options

Turn on:

 Element Selection

Note: It is also possible to customize the content of the Quick Access toolbar, adding or removing tools, through customization of 
the user interface. This may be easily accessed by picking Customize Quick Access Tool Bar from menu as illustrated above. 
When customizing the UI, it is important to know where the customizations are being written to. If the active file is a configured 
dgnlib, the changes will be written to that file. If the active file is NOT a configured dgnlib, changes will be written to the User’s 
Personal.dgnlib. Customization of the UI will be discussed in a later exercise.

11. Additional parts of the ribbon include any of the following:

 Ribbon Tab (tabs that contain groupings of related ribbon buttons, ribbon groups, button groups, etc.)

 Ribbon Button

 Ribbon Group

 Button Group

 Dialog Launcher (a small button located at the button of some groups that is used to open dialog boxes that containing settings 
related to that group)
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12. Integrated Settings

The ribbon also makes access to settings, where applicable, much easier. For commands that are supported by settings, you will find a 
“dialog box launcher” contained in the ribbon group. 

 Settings integrated into ribbon

 Accessible directly from ribbon groups

 Click on the dialog launcher in corner of group

We wish to add the County, State label in the title block of the plan sheet.

13. Select the active workflow as Drawing. Pick the Annotate ribbon tab.

Pick Place Text and set the text style to Civil‐TitleBlock.

In the Text Editor, key in Broward County, FL and observe the text in the Text Editor and the MicroStation view window.
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As can be seen, the text style appears to contain incorrect settings for use within the title block. It is using the wrong font, the text size is 
too large, and the justification is incorrect.

Tools such as the Place Text tool (contained in the Text ribbon group) or Place Active Cell tool (contained in the Cells ribbon group) have 
settings that support their usage. If we wish to place text, but need to adjust some of the text settings, it is possible to open Text Styles by 
clicking the dialog launcher located at the bottom right corner of the Text button group.

Within the Text ribbon group, click the dialog launcher:

The Text Styles dialog is opened. We can make any required adjustments from here without going to another location to access these 
settings.

In the Text Styles dialog we can see that the file contains a local copy of the text style, and it has been modified from the library definition.

In the Text Style dialog pick the text style Civil-TitleBlock, click the Advanced tab and enable Compare Against Library Style, and set the 
Mode to Differences.
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You can see the difference in the local style vs. the library style.

14. Pick Reset.

The text style updates.

15. Complete placing the text Broward County, FL in the location illustrated:

You may close the Text Styles dialog.

As was seen, accessing the Text Styles dialog in this manner was quite painless!
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Advanced Features of the Ribbon

The MicroStation CONNECT Edition also has a number of advanced features in the ribbon intended to help a user be 
more productive. These features include a ribbon search that searches for tools or dialogs across multiple workflows 
and ribbon tabs, the ability to show or hide features in the ribbon, and more.

In this lesson you will:

 Use the Ribbon Search

 Show/hide items in the ribbon

1. Continuing in RD_Sheets.dgn, open the sheet model Sheet 02.

This sheet model needs to have a sheet border placed, and there is a tool that our company has created to do this, we simply need to 
locate it.

Note: The model may be opened from the Models dialog or from the View Groups tool bar.

2. Within the ribbon, locate the ribbon Search.

The Ribbon Search

The Ribbon Search may be used to find tools or dialogs, searching across multiple workflows and ribbon tabs.

To search, enter the partial or full name of the tool or dialog and you will get a list of results with the given name in a window below the 
Search field.

It may be used to find tools or dialogs.
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Search results are categorized by:

 The Ribbon

 The Backstage

 The Quick Access Toolbar

(An example of the ribbon Search, where SAVE has been typed into the search field)

3. In the Search Ribbon field (F4) located in the upper-right corner of the ribbon, begin typing “border” and observe the search.
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2 results were found:

You need to place a B-Size border.

To observe the location of the tool, hover the cursor over B‐Size in the search results. The details of the tool will expand, showing the 
access points for the tool within the ribbon.

This tool is located in the Annotation tab of the LEARNing Connect workflow.

4. Open the location by clicking on the access point. The search navigates the ribbon to the particular tab where the sheet border tool is 
located.
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Observe the ribbon. The LEARNing CONNECT workflow has been activated, with the Annotation tab selected:

Note: Clicking the command in Search activates the tool rather than opening the access point. If a tool is activated from the search 
result, MicroStation stores this use and next time Search is opened, the tool is listed in the Most Recently Used category in the 
search results.

5. Pick B‐Size, and place the border by snapping to the lower right corner of the sheet boundary.
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6. Return to the Home tab in the Drawing workflow.

MicroStation has long provided the ability to customize the interface by enabling/disabling the display of items through the right-click. You 
may show/hide items in the ribbon using a right-click, toggling on/off what you want to see, including within the “More” tools that are part 
of some ribbon groups.

The Selection ribbon group contains several tools that we do not frequently use. We do, however, work with Multi-lines and would like to 
display the Multi-line tools.
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7. In the ribbon right-click over the Selection ribbon group and turn off the following tools:

 Select All

 Select None

 Lock

 Unlock

8. Repeat this for Groups, turning off:

 Group Hole
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9. Now let’s add the Multi-lines ribbon group. In a blank area toward the right end of the ribbon, right-click and pick Multi‐lines:
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Making Access to Tools Even Easier

The ribbon contains many additional features used to make accessing tools and settings easier. Ease of use leads to 
increased productivity. Some of these features help provide a “cleaner” desktop, while others are used to make 
selecting options and settings easier.

In this lesson you will:

 Access the ribbon group “Popups” menu

 Minimize the ribbon

 Access the view “Tools” popup menu

 View dockable dialogs

 Use Key Tips

1. Continuing in the BentleyCONNECTTraining WorkSpace and the QuickStartforCONNECT WorkSet, open Roadway Widening.dgn.

We wish to verify the areas of Parking Area A and Parking Area B.

2. Make Drawing the active workflow.
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We need to access the Measurement tools, but would rather not switch workflows or ribbon tabs.

3. Press <Space> on the keyboard to open the ribbon groups Popups menu:

The Popups tool box is displayed.

The ribbon groups Popups is a tool box that is opened by pressing the Space bar <Space> on the keyboard. It is a convenient way to 
access some of the most common tools that you use without having to switch from one tab to another.

The first row usually contains tools from the “Home” tab in the ribbon while rows two and three contain various selection/manipulation 
tools and other tool groups.

Let’s Explore this in more detail...

As you can see, the first row contains ribbon group shortcuts. These are shortcuts for frequently used ribbon groups in the Home tab. 
Here you have access to Attributes, Primary, Selection, Placement, Manipulate, Modify and Groups. Clicking or activating any of them 
opens the respective ribbon group pop-up.

The second row contains frequently used tools such as Element Selection, various manipulation tools, and Delete.

The third row contains shortcuts to frequently used ribbon groups. Each of the icons in the ribbon group have a shortcut key. This 
shortcut key is displayed when you hover the pointer over the icon.

With the ribbon group pop-up displayed, pressing the shortcut key will activate the respective tool or group. By default, this toolbox 
contains 3 rows of tools.

Note: It is also possible to customize the Popups tool box. When customizing, you can modify the existing Popups tool box, add 
additional rows of tools, and create custom versions of the Popups.
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4. Place the cursor over Measure and pause for a moment. A tool tip is displayed showing the shortcut for Measure is the letter <A>.

Either click the Measure button or press <A> to open the Measure tools.

Pick the Measure Area tool and measure the area of Parking Area A, verifying that the measurements are what we expect:

Parking Area A

Area: 90173 Sq.' (8377 Sq. M)

Perimeter: 1354' (413 M)

Accessing the Measure tools was very easy to do through the Popups tool box! In addition to the ribbon groups Popups tool box, 
MicroStation CONNECT offers several additional popup menus.

5. Minimize the ribbon by clicking the Minimize button located in the upper right corner of the ribbon.

The ribbon collapses and now operates as a fly-out menu.

Note: This works well when using the various pop-up menus to access the desired tools and provides a clean desktop with a 
minimal interface being displayed.
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6. Press <Q> on the keyboard to open the Quick Tools menu. This pop-up menu contains shortcuts to frequently used tools and ribbon 
group-pop-ups.

From the tool list pick Measure, followed by Measure Area, and verify the area and perimeter of Parking Area B.

Parking Area B

Area: 39617 Sq.' (3681 Sq. M)

Perimeter: 1007' (307 M)

Note: Either keyboard shortcut <Q> or <[> may be used to open the quick tools menu.

(Left ‐ Pop‐up menu displayed when you press <Q> | Right ‐ Pop‐up menu displayed when you press <[>)
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7. Open Bent Model.dgn. You see 4 views presented:

We wish to arrange the view windows as follows:

View 1: Top View (wireframe)

View 2: Isometric View (shaded)

View 3: Front View (wireframe)

View 4: Right View (wireframe)

Make View 1 the active view (click the title bar for View 1) and press <Shift> + Right‐click to open the view Tools menu.

Pick Top view.

Repeat this process, setting the rotation for each view window as instructed.
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8. With the right-click view “Tools” menu, use the Fit View tool to fit each of the views.

Note: Once the command is active, you may simply click sequentially in each view without repeatedly picking the Fit View 
command.

9. Using the right-click view Tools menu, set the presentation to Wireframe in views 1,3,4.

10. We now need to Save Settings in the model.
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The Quick Access toolbar contains the Save Settings command. We can of course click Save Settings in the Quick Access toolbar,

or we can use Key Tips to access the command.

The Key Tips and Tab Key Tips may be used to navigate the ribbon with the keyboard.

 Key Tips - The Key Tips [ F2] are used for picking the workflow, accessing the commands in the Quick Access Toolbar, and 
selecting the tabs in the active workflow.

 Tab Key Tips - The Tab Key Tips are used for accessing the tools in the tabs of the active workflow.

11. Press the function key <F2> to activate the Key Tips, followed by <4> to Save Settings.

The settings in the design file have now been saved.
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Branding a Design File

In the past, design files (DGN’s) had no idea what WorkSpace they were associated with. This could allow a DGN to 
unknowingly be opened in the wrong working environment causing the wrong standards to be applied. The MicroStation 
CONNECT Edition allows a DGN file to be branded to a WorkSet, with the WorkSet being linked to its associated 
WorkSpace.

In this exercise you will:

 Brand a design file

1. Continuing in the MicroStation CONNECT Edition, make the active WorkSet Example ‐ Civil.

We can see the list of Recent Files that have been opened in this WorkSet.
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2. From the list of Recent Files, pick the design file BSI400‐W01‐Survey.dgn (or pick Browse and select the DGN file).

When chosen, the file opens directly into MicroStation with the ribbon interface of the MicroStation CONNECT Edition displayed. We are 
ready to work in the model.

3. Click the File tab. You are taken to the backstage view.

4. From the list of Recent Files, pick the design file BSI400‐W01‐Terrain.dgn (or pick Browse and select the DGN file).

Again, the file opens directly into MicroStation.

5. Click the File tab. From Open in the Backstage, click the Browse button:

Navigate to the folder C:\BentleyCONNECTTraining\WorkSets\QuickStartfroCONNECT\DGN and pick Coordinates.dgn.

You are presented with the following:

This file has either not been opened in the MicroStation CONNECT Edition or was opened with No WorkSpace. The previous two files did 
not display this message because they had already been associated with WorkSet Example - Civil.
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6. Open the file using the active WorkSpace/WorkSet:

This design file has now been “branded” with the WorkSet Example - Civil. If an attempt is made to open this file with a different WorkSet, 
the operator will be prompted accordingly. We will see this in just a few moments.

7. Close the active file.

8. From the Work Page, pick Example ‐ Plant as the active WorkSet.

9. Open BSI700‐S0501‐Steel Details.dgn from the Recent Files list (or browse and pick any file from within this WorkSet).

Observe that the file opens directly in MicroStation without a WorkSet alert. This file is “branded” to the Example - Plant WorkSet.

10. From the View Groups toolbox, click Previous Model.

MicroStation attempts to open the file/model, but recognizes that the active WorkSet has changed from the WorkSet this file was branded 
with.

You may either activate and open it within the WorkSet it was branded with, or re-brand it with the active WorkSet.
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11. Pick Use and activate WorkSet Example - Civil and click Open.

The Civil WorkSet was been made the active WorkSet when the file opened. As can be seen during this exercise, the MicroStation 
CONNECT Edition has the ability to “brand” the DGN file with the WorkSet setting, and switch WorkSpaces on the fly.

Note: This capability can help prevent a file from being opened in the wrong WorkSpace/WorkSet. For MicroStation users that work 
with multiple WorkSets (i.e. for more than one customer), this can be a very useful feature.

12. Close the active design file.
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Incorporating Explorer into Everything You Do

When working on a project, many types of project related data may be encountered. Typical data may consist of 
designs, drawings and sheets originating from either MicroStation or AutoCAD. Of these, there are many components 
ranging from models to references, saved views and more. Any number of style definitions may exist such as 
dimension or text styles. There may be Items Types, Cells and Levels. Perhaps the project contains other, non CAD 
data such as Adobe PDF’s, Microsoft Word documents, Microsoft Excel workbooks, and their contents. The project may 
have raster data such as aerial imagery. Even data like video or perhaps website links could be part of a project. 
Explorer can help keep track of all this data and make it easy to find.

Explorer provides:

 Central Resource to organize your project data

 Hierarchical storage of information related to your project
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The Explorer Dialog and Settings

The Explorer dialog can be accessed from the Ribbon in several workflows. For example, in the Drawing workflow it is 
located it in the Primary group of the Home tab. The Explorer icon can be clicked to open the Explorer dialog. As can be 
seen, the Explorer consists of five panels: File, Items, Resources, Sheet Index, and Links.

You can access the Explorer Settings dialog from the Ribbon: File > Settings > User > Explorer Settings.
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Explorer contains a number of settings that govern its operation that range from turning on/off tabs in the dialog to controlling Explorer 
operations. The Explorer settings consist of the following:

File: 

 Visible — Allows you to set the visibility of the File tab in the Explorer dialog. You can show/hide the File tab by selecting Yes or No.

 Display — Allows you to select type of nodes that would be displayed in the Explorer dialog File tab. You can show/hide the nodes by 
selecting Show or Hide.

Items: 

 Visible — Allows you to set the visibility of the Items tab in the Explorer dialog. You can show/hide the Items tab by selecting Yes or No.

 Group By Relationship Type — If on, groups the items as per their relationship type.

Resources: 

 Visible — Allows you to set the visibility of the Resources tab in the Explorer dialog. You can show/hide the Resources tab by selecting 
Yes or No.

Sheet Index: 

 Visible — Allows you to set the visibility of the Sheet Index tab in the Explorer dialog. You can show/hide the Sheet Index tab by 
selecting Yes or No.

Links: 

 Visible — Allows you to set the visibility of the Links tab in the Explorer dialog. You can show/hide the Links tab by selecting Yes or No.

 Indexing Service — Starts or stops the DGN Indexing Service. Clicking the icon in the Indexing Service row opens the DGN Indexing 
Options dialog. You can start indexing and set indexing properties from this dialog.

Display Settings: 

 Zoom factor — Default magnification when the view is activated.

 Apply only to active view — Determines if the zoom factor is to be applied only to the active view.

 Include item groups — If on, the display includes all the items in the selected item type when zooming.

 Include related items — If on, activates the options to determine the nesting depth when zooming related items.
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 Select item groups — If on, activates the options to select item groups when node is selected.

 Select related items — If on, activates the options to select related item groups when node is selected.

Dialog Properties: 

 Browse Layout — Selects how the layout of the Explorer is displayed. Select Tab to display tabs or select Group Panel to display tabs 
as group of panels. Default setting is Group Panel.

 Properties Dialog Components — Defines the components that will be displayed in the Properties Dialog.

1. Start the MicroStation CONNECT Edition.

2. From the Work Page, select the Workspace: BentleyCONNECTTraining
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3. Change the WorkSet to Example - Civil

4. From the Browse button select the file: BSI400‐Sheets.dgn

5. From the Home tab of the Ribbon select Explorer.
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6. In the File panel, expand Models and right click on Beam Guide Rail Detail and select Activate.

Note: You are taken into this model.
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7. Now expand the node at Beam Guide Rail Detail.

8. View the content of the active model. The model content includes saved views, levels, named groups, rasters, point clouds, references, 
and elements.

Note: Right-clicking is also available for the other categories, like Dimension Styles, Levels, etc.
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Working with Explorer

You can use Explorer to find and edit many aspects of the design file.

1. Continue in the same file.

2. In the Beam Guide Rail Details model, expand the Elements node.

3. Expand the Text node.

4. Right-Click on Text: BSI 400
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5. Select Isolate

You will now see the text in the lower right corner of the sheet.

6. Right click on Text: BSI 400 again and select Clear Isolate.

7. Right Click on the Elements category and review the Organize By menu.
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Using Explorer to Perform Searches

With Explorer you can search for objects within the tree. You can either perform a Simple search, Criteria search, or an 
Advanced search. Simple searches allow you to conduct a search based upon searched text. Criteria searches allow 
you to create simple queries. Advanced searches let you build complex search conditions that can be saved for later 
use. Search results are stored in a folder that is named after the search condition. From the right-click menu of the 
search results folder you can save the results as report definitions (only for Criteria and Advanced search), edit search 
criteria, delete search criteria, or view properties.

1. Continue in the same file.

2. Select Search from the Explorer dialog.

3. In the Search window type in “1901” and press Enter.

You get a string of text with the characters “1901” in it.
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4. Review the Explorer window and note that at the bottom there are results for the Searches.
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Implementing Property Driven Annotation

In this workbook we will create a text element to be used as a template for Annotation. The text element will have 
multiple text fields embedded in it and you will then add this as a cell model to our cell library. The label cell will be used 
with the label tool in later exercises. We will label existing trees, shrubs and ground cover areas. Each area or cell has 
item types attached. These labels are formatted based upon the label cell used.

Note: that the exercises contained in this workbook are designed to follow a specific workflow called LEARNing CONNECT. The workflow is set 
via the Workflow toolbar shown below. The purpose of the LEARNing CONNECT workflow is to simplify the menu choices for the new learner. 
However, you may also use the standard Drawing workflow. The location of the Ribbon Tabs, Ribbon Groups and Tools are identical for both 
workflows.

You will learn how to:

 Create Text Fields from Element Properties

 Create a Label Cell

 Place a Label

 Edit Properties of Item Types



Copyright © 2016 Bentley Systems, Incorporated 63DO NOT DISTRIBUTE - Printing for student use is permitted

Creating Text Fields for use with Labels to Annotate

In this exercise, we will create a text element to be used as a template for Annotation. The text element will have 
multiple text fields embedded in it and you will then add this as a cell model to our cell library. The label cell will be used 
with the label tool in later exercises.

 Creating Fields from Element Properties

 Create Label Cell

1. Start MicroStation, from the Work page, pick the following:

WorkSpace: BentleyCONNECTTraining

WorkSets: QuickStartforCONNECT

2. Pin the project to the List and pick Browse to view the files in the DGN directory.

3. Open the design file LandscapeRD_4.dgn from the DGN project directory. 

4. Once the file is open, set the workflow to LEARNing CONNECT. 
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5. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.

6. Next, set the Level in the Attributes Ribbon Group to the Annotation level.

7. Begin by creating the Label Cell that is to be used for placing Labels on Elements. From the Annotation Ribbon Tab, select Place Text 
from the Text Ribbon Group.
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8. Set the Text Style to be 3.28 ft (1M). 
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9. In the Text Editor, select Insert Field or right press in the Text Editor and pick Insert Field. From Select Field Type, pick Element 
Properties and OK, you will be prompted to select an element, select one of the Trees.



Copyright © 2016 Bentley Systems, Incorporated 67DO NOT DISTRIBUTE - Printing for student use is permitted

10. Select the Property, Item No. under Tree Planting and select OK.
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11. At the Text Editor, provide a carriage return or <Enter> at the end of the Item No. string. Continue by using the same steps adding not 
only the Item No, but also Common Plant Name and the Botanical Plant Name, each on it own line as shown. Place the 3 lines of text in 
the DGN. Location is unimportant, anywhere is fine.

12. Next place a Fence or Element Selection around the 3 lines of text to be used as a label cell. Since this is a cell, define the Cell Origin as 
well as open the Cell Library dialog.
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13. From the Cell Library dialog, pick Create. Provide the Name and Description as shown, then click Create.
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Using Text Labels to Annotate 

In this exercise we will label existing trees, shrubs and ground cover areas. Each area or cell has Item Type data 
attached. These labels are formatted based on the label cell used. 

 Place Label

1. Start MicroStation, select:

WorkSets: QuickStartforCONNECT

2. Pin the project to the List and pick Browse to view the files in the DGN directory. 

3. Continue in the design file LandscapeRD_4.dgn from the DGN project directory. Or open LandscapeRD_4‐2.dgn.

4. Once the file is open, set the workflow to LEARNing CONNECT. 

5. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.
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6. From the Annotation Ribbon Tab, select Place Label from the Notes Ribbon Group.

7. Set the options for Place Label as shown. Place the location of the label, then data point on a Tree cell itself. Label the Gumbo Limbo 
Trees as well as Shrubs.
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8. Continue placing at least three labels. Note that if the location of the text cell is incorrect, remember to use move and move it to a better 
location. 
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Annotative Hatching and Patterning 

In this exercise, you will open the Survey file, adding hatching and patterning using Annotative Hatching. You will place 
this based on our sheet scale, 1”=50’. You then will open the sheet that has the Survey file referenced, change the 
annotation scale, observing that the spacing of hatching and patterning will adjust accordingly.

 Annotative Hatching of geometry in the active file

 Associative Boundary

 Drop Pattern

 Annotative Hatching of geometry in the reference file

1. Start MicroStation, from WorkSets select the WorkSet called QuickStartforCONNECT. Pin the project to the List and pick Browse to view 
the files in the DGN directory. 

2. Open the design file, Survey Topo 03.dgn from the DGN project directory. 

3. Select the Workflow, LEARNing CONNECT.

4. In our example, the data will be used as a reference in a Construction Plan. The Construction Plan is designed to be printed at 50’ to 1”. 
You need hatch lines that will be spaced at 1/4” and 1/2” inch on the printed sheet, regardless of the print scale. We will make use of 
Annotation Scale so that hatch lines are now associated to the Annotation Scale, just as text is. From the Annotation Ribbon Tab, set the 
Active Level to Building. Then from the Patterns Ribbon Group, select Hatch Area.

5. From the Utilities Ribbon Tab, set the Annotation Scale to 1”=50’.

6. You need to hatch the building in the bottom of our view with the hatching spaced at 1/4” on the printed sheet. Set the Hatch Area tool as 
shown, select the building with a data point and accept with another data point at the lower right corner of the building. This point defines 
our hatch or pattern intersection point. Note that you input the Spacing in Sub Units. You key into the Spacing field “ :1/4”. The colon 
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separates the Master Unit from the Sub Unit, in this case we are keying Zero Master Units/Survey Feet and One Quarter of a Sub Unit or 
Survey Inch. It will be converted to its decimal equivalent (0.0208).
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9. Build a selection set of the rest of the building shapes, except the mall shape. Hatch them with 1/4” spacing. 



Copyright © 2016 Bentley Systems, Incorporated 76DO NOT DISTRIBUTE - Printing for student use is permitted

10. The larger building is representative of a shopping mall. It also needs to be hatched, but it will receive 1/2” hatch line spacing. Using 
Hatch Area, setting the Spacing to “:1/2”. Place the intersection line at the lower left hand corner of the building.
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11. Each building was hatched with the Annotation Scale Lock on, allowing the hatching to be tied to the active Annotation Scale. Set 
Drawing Scale to 1” = 100’ and note the hatch lines maintain the correct spacing based on the final plot scale.
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Changing the Display of Elements with Display Rules

This section contains exercises where existing landscape elements will be displayed differently from how they were drawn. For example, in a 
landscape plan you have numerous trees and shrubs that have been installed. The cells for trees, shrubs and ground cover need to be 
isolated. In this case you will need to display just the shrubs and “gray scale” the trees, ground cover, and existing roadway geometry. You will 
create Display Rules that are applied to a Display Style. Here we have landscape elements and ground cover, several types of which that 
need to be maintained by irrigation and watering. You have also been given data that was created on the correct level and displays correctly 
for the specific group that created it, but needs to display differently in our construction plan. 

Note that the exercises contained in this workbook are designed to follow a specific workflow called LEARNing CONNECT. The workflow is set 
via the Workflow toolbar shown below. The purpose of the LEARNing CONNECT workflow is to simplify the menu choices for the new learner. 
However, you may also use the standard Drawing workflow. The location of the Ribbon Tabs, Ribbon Groups and Tools are identical for both 
workflows.

You will learn how to:

 Apply an existing Display Rule to Landscape Geometry

 Create a Display Rule Set, displaying just trees and changing the transparency of existing landscape features

 Create a Display Rule based on Area

 Create a Display Rule based on Level
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Changing the Display of Landscape Elements

In this section you will display existing landscape elements differently than how they were drawn. For example, in your 
landscape plan you have numerous trees and shrubs that have been installed. The cells for trees, shrubs and ground 
cover need to be isolated. In this case you will need to display just the shrubs and “gray scale” the trees, ground cover, 
and existing roadway geometry. 

We begin by creating a Display Rule that is associated with a Display Style. A Display Rule is actually a set of rules and 
conditions applied on a “per view” basis. Display Rules control the symbology, appearance, and display of design 
elements based on properties of an element, named group, view, model, reference, or file.

 Apply an existing Display Rule to Landscape Geometry

 Create a Display Rule Set, displaying just trees and changing the transparency of existing landscape features
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1. Start MicroStation, from WorkSets select the WorkSet called QuickStartforCONNECT. Pin the project to the List and pick Browse to view 
the files in the DGN directory. 

2. Open the design file LandscapeRD_2.dgn from the DGN project directory.

3. Once the file is open, set the workflow to LEARNing CONNECT. 

4. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.
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5. Next, pick View Attributes from the View or <CTRL B>. From View Attributes, pick Open Display Styles Dialog, followed by Display 
Rules.

6. From Display Rules, change the value from (none) to All Shrubs, and note the changes in the view.
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7. From Display Rules, pick New Display Rule Set and name the new Rule, All Trees. Pick New Display Rule, and select Applies always.

8. Next, on the Condition Editor, set the Pick Property option to Element>Tree Planting>Is Tree Planting, followed by OK.

9. Then, select Add new action. Select Symbology Overrides and select the symbology preview dialog. Next, set the color to red, with the 
weight set to 0.

Note: Actions can be set to Hide an Element, Override its Symbology (just completed), Define a new Element Priority, Define a Display 
Style Override, or Hatch/Pattern an Area.

10. Pick New Display Rule and again pick Add new action from the second line, Applies always. Set this to Symbology Override.
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11. Next, set the Actions to 90% Transparency.
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12. In Display Styles, set the Display Rules to All Trees. And again notice the difference between All Trees and All Shrubs.

13. Each Condition is processed in order. For example, the conditions process everything in a file on a level called “temp1” to be changed to 
color gray. Those elements are now processed and gray. For example select the Display Rule>All Trees, pick the processing #2 and pick 
Move Selected Rule up and make it a higher priority. Note what occurs with the view. Move the Condition down to have a lesser priority. 
Again note the difference.Set the Display Rules back to (none) when complete. Also note the Stop if True option. 
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Creating a Display Rule to Display Maintained Areas based on Square Footage

In this section, you will create a Display Rule for displaying areas that need to be maintained. The new Rule will only 
display areas that have the Maintain Item Type Property and those that are less than a specific square footage. The 
larger areas can be mowed by commercial mowers while the smaller areas will need to be done by hand. 

 Create a Display Rule based on Area

1. Continue in the design file LandscapeRD_2.dgn from the DGN project directory.

2. Once the file is open, set the workflow to LEARNing CONNECT. 

3. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.

4. Turn off the level in the reference file, Parking Median (Survey Topo 03.dgn). Note that if an element is turned off, it cannot be processed 
by the Display Rule.

5. Pick View Attributes. Then from View Attributes, select Open Display Styles dialog, followed by Display Rules. Select the Display Rule 
Set called Mow or Maintain and pick Create Duplicate Display Rule Set and name the new rule set, Smaller Mower Required.
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6. Define the conditions as shown.
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7. Next, set the Symbology Overrides to color 2 and weight 3. Apply the Display Rule Smaller Mower Required..
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Creating a Display Rule to Display Silt Fence and Property Lines to match our Symbology

In this section you have been given data that was created on the correct level and displays correctly for the group that 
created it, however, we need it to display differently in our construction plan. 

 Create a Display Rule based on Level

1. Open the design file LandscapeCN_1.dgn from the DGN project directory.

2. Once the file is open, set the workflow to LEARNing CONNECT. 

3. Apply the saved view Parcel 1. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved Views and provide a 
data point within the view.
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4. Pick View Attributes from the Presentation Ribbon Group in the View Ribbon Tab. Then, from View Attributes, select Open Display 
Styles dialog, followed by Display Rules. Create a new rule set by picking New and naming the new rule set Silt Fence and Parcel Bound. 

5. Select Silt Fence and Parcel Bound from Display Rules, then pick New Display Rule, the pick Applies always, then define the condition to 
the level to equal Silt Fence, pick OK when complete. (Element > Element Common Properties > General > Level). Next Add new action, 
by picking the “Green Plus”. Pick Symbology Overrides and set the symbology to Color = (3) RED, set the line style to “Gen_Fence” and 
the line weight = 2.

6. Next, select Silt Fence and Parcel Bound from Display Rules. Pick New Display Rule, set Applies always, then define the condition to the 
level to equal Plan Prop Boundary RW, pick OK when complete. (Element>Element Common Properties>General>Level). Next Add new 
action, by picking the “Green Plus”. Pick Symbology Overrides and set the symbology to Color = (9) GRAY, set the Weight = 0, and set 
the Transparency Overrides to 30%. 
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7. You will notice the Property Boundary lines have a dimensions (labeled line) displayed. They are on the incorrect level, so we cannot just 
simply turn off the default level. Add another New Display Rule, then pick Applies always, then define the condition to the level to equal 
Default, select Add new criterion and select Element, followed by Dimensions then Is Dimensions, pick OK when complete. Next Add 
new action, by picking the “Green Plus”. Pick Hide Element. Note that after selecting Hide Element, you can select it again to turn the 
element described back on.
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Sheet Creation and Indexing

Sheet creation is a time consuming process causing inconsistencies and delays in the delivery of projects. Tracking the number and the order 
of sheets is a tedious and error-prone manual process.  With numerous Drawing Composition Innovations implemented within MicroStation 
CONNECT, your will improve the consistency and quality of sheet layouts and speed up the process of creating and delivering well-organized 
sheet sets.  Discover capabilities like creating multiple sheets in a single operation and automated layout based on scale, location or along a 
path.  Master simplified Sheet Indexing that enables the use of a central location to index sheets and control the number, order, properties of 
sheets and make publishing deliverables easier.

You will learn how to:

 Manage Sheet Models through the Sheet Index tab of the Explorer dialog

 Place a Named Boundary using the By 2 Point method and rectangular array method

 Adjust the extents and positioning of a Named Boundary

 Generate a new sheet model that contains the content of a Named Boundary

 Work with Reports to create a custom-tailored index sheet

 Format and Place a drawing sheet index as a table

 Print Sheets in a Sheet Index
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Sheet Indexing

A sheet index is a centralized and structured collection of sheets in your project. Sheet index can be useful in creating a 
construction document set (also called as sheet set or construction set) that contains all the sheets of your project. You 
may link any sheet model from any design file of your project into a sheet index. Sheet numbering rules enable you to 
define rules to generate sheet numbers for all sheets in the sheet index. Sheets can be organized hierarchically in 
folders, with the ability to override sheet numbering rules for sheets in each folder. Custom properties can be attached 
to sheets and placed as text fields in the sheet. Custom properties can also be attached to the folders and the sheet 
index. The sheet index is managed from the Explorer Dialog Sheet Index Tab.

 Utilizing Explorer, create an organized hierarchy of folders

 Link sheet models from design files of the project into their respective folders within the sheet index

 Manage properties (sheet numbering, sheet numbering prefix) of the sheet models within the sheet index
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Creating a Named Boundary and Placing the Content On a New Sheet

A named boundary is any closed element that has a name associated with it. Previously, we could create named fences 
from fences, clip volumes, and clipped masks. Named fences have been renamed as named boundaries. You can 
place named boundaries using drawing boundaries. Named boundaries may also be grouped for processing sets of 
drawings onto sheets. 

In this section, you will learn to: create a Named Boundary and placing the content of the Named Boundary in a sheet 
model. The following features are covered:

 Placing a Named Boundary using the By 2 Points method

 Generating a new sheet model that contains the content of the Named Boundary
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1. Start MicroStation, from the Work page, pick the following:

WorkSpace: BentleyCONNECTTraining

WorkSets: EnhancingAnnotation_BLDG

2. Begin by opening the BSI300‐GroundFloorPlan.dgn and zoom into the upper-left corner of the floor plan.

3. Along the Ribbon, click the Home tab. From the Attributes group, make the A‐Z017‐G‐DBnd level active via the Level Picker.

Hint: Use the search field and type, “draw” to truncate the level list.

4. Next, click the View tab. From here, select the Place Named Boundary tool from the Named Boundary group.
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5. In the tool settings window, set the method to By 2 Points. In the Name field, type Staircase A and enable the option, Create Drawing. 

6. You are prompted to enter the first point. Issue a data point (left mouse click) above and to the left of the A4 column.

7. Move your mouse down and to the right, and issue a data point for the opposite corner as shown. 
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8. Next, you are prompted to enter the view orientation. Move your mouse so that it will index (bold white line) with the X-axis of the 
AccuDraw compass. Issue a data point to fix angle and then issue another data point to accept. 

9. The Create Drawing dialog opens. Ensure that Staircase A is in the Name field. From the Drawing Seed drop-down menu, choose 
Detail_2D_SheetOnly.

10. In the Create Sheet Model section of the dialog, enable the checkbox to the left of the Filename field. Click the Browse Sheet File icon to 
the right. Select the BSI300‐Sheets.dgn and then click the Open button.

11. Set the Detail Scale for 1:50 from the drop-down menu. Ensure that Open Model is enabled and then click OK. 
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The newly created sheet model opens with the Named Boundary referenced to the sheet.

12. Next, on the Ribbon, click Home > Primary > Models. 

13. The Models dialog opens. From here, click once and then click twice onto Staircase A under the Name column. Let’s rename the model, 
Enlarged Detail Plans. Click into the white space below to commit the change. Do the same for the Description. 

Take note of the sheet number for this model. Next, we will incorporate this sheet into the sheet index.

14. If the Explorer is not still open, click Home > Primary > Explorer. Click the Sheet Index tab to make it active and then icon, Open Sheet 
Index for Edit.

15. Highlight the 400 ‐ Enlarged Detail Plans folder and then click the Add Sheet icon.

16. Select the BSI300‐Sheets.dgn and click Open.

17. Click the arrow next to the file name in the Add Sheet dialog. Select the Enlarged Detail Plans sheet and click OK when finished.



Copyright © 2016 Bentley Systems, Incorporated 98DO NOT DISTRIBUTE - Printing for student use is permitted

By adding this sheet to index, the properties that we set for numbering for each folder was applied to this sheet. Take notice to the 
drawing title and the sheet number in the Models dialog. Furthermore, our title block has been updated with sheet number. If need be, the 
sheets can be rearranged in the Sheet Index. Thus the sheet numbers within the respective sheets will then update.

Another property that we set to our sheet index was a custom property for the project number.

18. Zoom into the title block. From the Text group of the Annotate tab, select the Edit Text tool.

19. Identify the text element, ####. In the Text Editor, click the Edit Field icon.
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20. The Fields Editor opens. Expand the Index Properties tab and select the Project No. field. Click OK when finished.

21. Issue a data point into the view to commit the text changes.
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Placing Named Boundaries Using the Array Method

In this section, you will break up a large floor plan by creating a rectangular array using the Named Boundary tool. 
When creating a rectangular array, through the tool settings, you can determine how many rows and columns as well as 
the spacing between each of them. Arrays are especially useful if an overlap of sheets is desired. The following features 
are covered:

 Placing the Named Boundaries using the array method

 Generating a new sheet model that contains the content of the Named Boundary

 Populating the drawing sheet index
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1. Open the BSI300‐GroundFloorPlan ‐ Quad.dgn.

2. Make the Place Named Boundary tool active (View > Named Boundary).

3. In the tool settings window, set the Method to Drawing Boundary.

4. From the Drawing Boundary pull-down menu, select NB ‐ Full Sheet. This was the first drawing boundary that we created in the Dgn 
Library.

5. Type Ground Floor ‐ Quad into the Name field.

6. Click the icon for the mode, Place rectangular array of named boundaries.

7. Set the Rows at 2 and Columns at 2.

8. Set the spacing for both the Rows and Columns to be ‐1000 and ensure that Create Drawing is enabled.

9. Bring your cursor into the view. You will notice a rectangular shape. This is lower-sheet in the array and there will be dots for any 
additional sheets based upon the number of rows and columns you’ve entered.

10. Position your cursor so that the upper-right corner of the rectangle inside the center corridor. Issue a data point to accept.



Copyright © 2016 Bentley Systems, Incorporated 102DO NOT DISTRIBUTE - Printing for student use is permitted

11. The Create Drawing dialog opens. From the Drawing Seed drop-down, choose Plan_SheetOnly.

12. Enable the check box to the left of Filename. Then click the Browse Sheet File icon to the right. Browse to and select the BSI300‐
Sheets.dgn.

13. Leave the option to (New) from the Sheets drop-down menu and leave the Detail Scale at 1:50.

14. In the Sheet Properties section, enable the option Add To Sheet Index and then click the icon Select a folder from Sheet Index.

15. Highlight the 100 ‐ Plans folder and click OK.

16. Confirm all the settings as shown and then click OK when finished.
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17. The four sheet models are added to the BSI300‐Sheets.dgn as well as being included in our drawing sheet index. In our next section we 
will place a table representing the drawing sheet index. 

Note: Since these Quads are Saved Views referenced to our sheets, you need to adjust settings in the source file and not here in the 
sheet. In this example, the BSI300‐GroundFloorPlan ‐ Quad.dgn. This could be anything from turning on/off levels to adjusting the extents 
and positioning of the named boundaries. If this is the case, the Saved View may need to updated so that those changes are propagated 
downstream where ever these are referenced.
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Place the Sheet Index as a Table

An index table for our cover sheet can be generated from the sheet index. By clicking the Place Table icon, this starts 
the Place Table tool to place the index sheet. An index sheet contains properties of all the sheets in the sheet index that 
is placed as a table. Once placed, a report definition of the index sheet is also created in the Reports dialog. The 
following features are covered:

 Working with Reports to create a custom-tailored index sheet

 Placing sheet index as a table in the Cover Sheet
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1. Open the Explorer (Home > Primary).

2. From here, click the Sheet Index tab, expand the 000 ‐ General folder, and then double-click the AE001 Cover Sheet.

3. Set the active level to A‐Z013‐G‐Legn via the Level Picker (Home > Attributes).

Hint: Use the search field and type in, “leg” to truncate the level list.

4. In the Explorer, along the icon bank of the Sheet Index tab, click the Place As Table. 
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5. Bring your cursor into view but do not issue a data point to place the table. Rather, observe the resulting preview. Reset (right-click) to 
cancel the command.

We certainly could have placed the table. However, to get the desired result for our project, it would’ve taken many modifications to it. 
Let’s take another approach for creating our sheet index.

6. Along the Ribbon, select the Analyze tab. From here, click Reports. 

7. The Reports dialog opens. From here, expand the Sheet Index Reports folder and then select the Sheet Index report definition.

Note: The said Sheet Index Reports will only exist after the Place Table icon is clicked from the Sheet Index tab and not before.
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8. Next, along the icon bank, click the Copy to clipboard. 

9. Select the Sheet Index Reports folder, click the Paste from clipboard icon 

10. Then, rename this definition to Drawing Sheet Index.

11. Expand the newly copied Drawing Sheet Index report definition. In here, expand the Columns.

12. Delete all the columns except for Folder Name and Sheet Number.

13. Highlight Columns and then in the Properties section, click Add Columns.
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14. In the Select Columns to Add dialog, expand Model Link, then General, and then select Model Name. Click OK when finished.

15. Right-click the Sheet Number column and choose Rename from the pop-up menu. Change the name to Sheet.

16. Right-click on Model Name and rename it to Title.

17. Expand the Sorting Rules and delete all of the existing rules.

18. Right-click on Folder Name and choose Sort on this column.

19. In the Properties section, for the Hide Repeated Values select Yes from the drop-down menu.
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20. Right-click on the Sheet column and choose Sort on this column. We’ll leave the Sorting Options as-is.

21. Our Drawing Sheet Index report is now finished. Both the Reports dialog and Explorer can place this table.

22. From the Reports dialog, click the Place as table icon. 

23. In the tool settings window, set the Text Style to T5.0 mm, select Drawing Sheet Index from the Report drop-down, and toggle on Retain 
Association. 

24. Position your cursor in the upper-left corner of the Cover sheet and issue a data point to place the table.
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Printing Sheets in a Sheet Index

Once sheets are added to a sheet index, you can print all or a subset of the sheets by clicking the Print Organizer icon 
in Explorer's Sheet Index tab. Explorer seamlessly integrates with Print Organizer in a variety of ways to make it easy 
for you to print your project data. 

 Printing sheet set via Print Organizer
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1. Begin by clicking the Open Print Organizer icon from the icon bank of the Sheet Index tab. 

2. The Select Print Style dialog then opens with available print styles. From here, select PDF (full Size) and then click OK.
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3. The Print Organizer opens. As you can see here, the folder structure was preserved. 

4. In the icon bank of the Print Organizer, click Print.

5. Confirm the settings below, making sure to enable Open print file after creation. Click OK to publish the PDF.
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6. Your sheet set PDF document opens...
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Attaching Quantity Data Using Item Types

The following section contains exercises to precisely place cells representing trees that will eventually be tied to a Tree Item Type. Item Types 
are used to generate quantity based reports. You will change an existing closed shape into a Ground Cover element via its Item Type. Item 
Types are used to add non-graphic properties to a MicroStation element. You will draw Ground Cover areas represented by closed shapes 
tied to Item Types. You will master how Element Templates can automatically assign those Item Types to cells representing different types of 
Shrubs. You will review and edit Item Type Properties of differing element types.

Note: The exercises contained in this workbook are designed to follow a specific workflow called LEARNing CONNECT. The workflow is set via 
the Workflow toolbar shown below. The purpose of the LEARNing CONNECT workflow is to simplify the menu choices for the new learner. 
However, you may also use the standard Drawing workflow. The location of the Ribbon Tabs, Ribbon Groups and Tools are identical in each 
workflow.

You will learn to:

 Use of existing Saved View

 Placing a Cell without Data attached

 Review Properties of an element

 Attach Item to Element

 Edit Properties of Item Type

 Item Types and Templates



Copyright © 2016 Bentley Systems, Incorporated 115DO NOT DISTRIBUTE - Printing for student use is permitted

Placing a Simple Cell as a Tree, Without Data Attached

In this exercise, you will open a MicroStation design file, use a Saved View to locate the correct location, place a simple 
cell representing a Tree for a landscape plan, then review its properties. This cell will have nothing special about it, no 
external links and no connection to any Item Type. However it will be used in a later exercise.

 Use a Saved View

 Place an Existing Cell at known locations

 Review Properties

1. Start MicroStation, from WorkSets select the WorkSet called QuickStartforCONNECT, Pin the project to the List and pick Browse to view 
the files in the DGN directory. 

2. Open the design file LandscapeRD_1.dgn from the DGN project directory. Once the file is open, set the workflow to LEARNing CONNECT. 

3. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.
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4. Next from the Home Ribbon Tab, select Place Cell from the Placement Ribbon Group.

5. Set the Active Cell to the cell, Tree ‐ Gumbo Limbo and all the other settings as shown. You will place two symbols or cells representing 
trees in a parking island. Also ensure that there is currently NO template assigned, the template should be set to None.
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6. With the cell, Tree ‐ Gumbo Limbo active and on your cursor, place the cell at the location XY= 901798,648083. To place the cell at this 
exact location type (while in the Place Active Cell command) pick <ESC> and <ENTER> , then type XY=901798,648083,the coordinate 
value into the keyin, press <ENTER> and the cell is placed at that location.
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7. Next Zoom In or Window Area on the newly placed Tree. Select the cell, then <Right Press> on the mouse and pick Properties. Note that 
this is a simple cell, placed in the correct location but without any properties of the tree, such as, who or when the tree was placed. After 
reviewing its lack of properties, close the Properties dialog. 
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Adding Item Types and Reviewing Properties of an Existing Element

In this exercise, you will open a MicroStation design file representing a landscape construction plan. Then using a 
Saved View, locate the correct location in our design. You will attach an existing Item Type, representing a Tree, that 
contains all the planting information you may need to create your construction plan. You then will review the attributes 
or properties of the Tree Planting.

 Attach existing Item Type

 Review Item Type using Element Selection

1. Continue in the design file LandscapeRD_1.dgn from the DGN project directory.

2. Once the file is open, set the workflow to LEARNing CONNECT. 

3. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.

4. Verify the tree cell near the upper right corner of the Building outline does not have Item Type properties defined. Use the Element 
Selection tool to select, then right press and pick Properties. 
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5. From the Attach Ribbon Tab, select Attach Item from the Item Types Ribbon Group. 

6. Selecting the Item Type, Tree Planting, fill in the Properties as shown and data point on the cell representing the tree. 

Hint: Remember that Item Types and their properties can be attached to Elements, Models or Element Templates.

7. Next using Element Selection, review the properties of the Item Type. Right Press and pick Properties with the cell selected. 

Hint: Remember that any Property can be edited and changed here. Simply high-lite the Property in question, edit it and accept with a 
data point. 
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Placing a Cell with Item Types Attached using an Element Template

In this exercise, you will open a MicroStation design file, use a Saved View to locate the correct location. You will place 
a cell and through a locked Element Template define an Item Type. The Item Type attached represents a Tree. The 
attached data contains all the planting information. You then will review the attributes or properties of the Tree Planting 
and edit it.

 Element Template Association to Cells

 Editing Item Type Properties

1. Continue in the design file LandscapeRD_1.dgn from the DGN project directory.

2. Once the file is open, set the workflow to LEARNing CONNECT. 

3. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.

4. Next from the Home Ribbon Tab, select Place Cell from the Placement Ribbon Group. 
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5. Set the Active Cell to the cell, Tree ‐ Gumbo Limbo and all the other settings as shown. You will place the second of two symbols or cells 
representing trees in a parking island. 
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6. From the Home Ribbon Tab, select Element Template Association from the Attributes Ribbon Group, next set the Active Template to 
Landscape > Tree Planting > Gumbo Limbo.
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This will set the template defined for the Gumbo Limbo tree. The cell will have the following properties assigned.

7. With the cell, Tree - Gumbo Limbo , active and on your cursor, place the cell at the location XY= 901836,647820. To place the cell at this 
exact location type (while in the Place Active Cell command) pick <ESC> and <ENTER>, then type the coordinate value into the key-in, 
press <ENTER> and the cell is placed at that location.

8. Next Zoom in or Window Area on the newly placed Tree. 
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9. Select the cell, then Right Press and pick Properties. Note the Item Type properties of the tree, cell. After reviewing, change the Installed 
by field to <Your Name>, and close the Properties dialog. 
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Creating, Formatting and Using Reports

The following section contains exercises to create several reports, one for Shrubs and another for Trees. Both items 
have Item Types tied to cells in the Landscape design file. Our Report Definitions will be created in the attached 
DGNLIB. You will format the report as well as define sorting options. You will create another report for Ground Cover, 
but not only do we want our Item Types reported on, we also want to quantify the Ground Cover elements area in 
square footage.You will create a report based on Item Types but also display both the count or number of elements and 
the length of each line or line string. 

Note that the exercises contained in this workbook are designed to follow a specific workflow called LEARNing 
CONNECT. The workflow is set via the Workflow toolbar shown below. The purpose of the LEARNing CONNECT workflow 
is to simplify the menu choices for the new learner. However, you may also use the standard Drawing workflow. The 
location of the Ribbon Tabs, Ribbon Groups and Tools are identical for both workflows.

You will learn how to:

 Create Reports

 Reporting on Item Types and Linear features.

 Create a new Report Definition

 Add Columns to Report

 Sort Report on Columns

 Formatting of Columns

 Report on Element Area
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Create Reports for Trees and Shrubs

In this exercise, you will create two separate reports, one for Shrubs and the other for Trees. Both items have Item 
Types tied to cells in the Landscape design file. Our Report Definitions will be created in the attached DGNLIB. You will 
format the report as well as define sorting options.

 Reports

 Create a new Report Definition

 Add Columns to Report

 Sort Report on Columns

 Formatting of Columns

1. Start MicroStation, from WorkSets select the WorkSet called QuickStartforCONNECT, Pin the WorkSet to the List and pick Browse to view 
the files in the DGN directory. 

2. Open the design file LandscapeRD_5.dgn from the DGN project directory. Once the file is open, set the workflow to LEARNing CONNECT. 

3. Apply the Saved View Parking Lot and Landscape. From the View Ribbon Tab select Apply Saved View from the Ribbon Group Saved 
Views then provide a data point within the view.

4. Explore the geometry you need to run reports on. Apply the All Trees Display Rule, then All Shrubs, followed by Mow or Maintain. 
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You will need to create reports on the Trees, the Shrubs, Ground Cover and Fence. Once you have seen the geometry, go ahead and set 
the Display Rule back to (none).Each Tree, Shrub, Fence, Ground Cover is attached to an Item Type.

5. Dock Explorer (you may need to change the Workflow temporarily to Drawing) from the Primary Ribbon Group, from the Home Ribbon 
Tab, dock Explorer to the right side of MicroStation as shown. Then select Items and Fencing, followed by one of the Properties under 
Fencing as shown. 

Note the highlighted element. With the Element Highlighted, right press and pick Properties. Note the Item Type Fencing and the Fencing 
Properties tied to the Element are displayed. You can also hold <CTRL> down and select another Fence line and it will be added to your 
selection set. You can modify the Item Type Properties from the Explorer dialog. Dismiss the selection when complete.



Copyright © 2016 Bentley Systems, Incorporated 129DO NOT DISTRIBUTE - Printing for student use is permitted

6. Open the Dgnlib, Landscape.dgnlb from the \QuickStartforCONNECT\Standards\Dgnlib directory.

Best Practice: It should be noted the best place to create Reports is in a configured Dgnlib not within the active file. Earlier we created 
Item Types in the local file, while noting the Dgnlib is the best place to create them. The same applies for Reports. This is a best practice. 

7. From the Analyze Ribbon Tab, select Reports from the Reports Ribbon Group.

8. On Reports, pick New category. Name the category to Landscaping. Then right press on the new category and pick New Report 
Definition. Naming the new Report, Trees Report.

9. Set the options for properties to be Model for the Location Type, set the Location to be specific file and Landscape RD_5.dgn., the Item 
Types are NOT in the current file but rather in the Landscape files. Set the Model to Default, No for both Reference and Cell Contents. 
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10. Next set the Item Types to Landscape Planting > Tree Planting.

11. Landscaping > Trees Report select Columns and from the right side of the Reports dialog, select Add Columns.
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12. Expand Tree Planting and select each Property with a check mark, selecting OK when complete.

13. To sort the report on any column in the report, right press on the column name. Right press on Item No. and pick Sort on this Column.

14. Select the Item No. under the Sorting Rules and set the Sorting Options as shown.

Formating can be added to any column in the report by right-clicking on the column name. 

15. Right press on the Common Plant Name and pick Add Formatting. In this case set the Case to Upper.
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16. Open the design file LandscapeRD_5.dgn from the project directory (the report can be run from the active file) and navigate to the Saved 
View, Parking Lot and Landscape.From the Analyze Ribbon Tab, select Reports from the Reports Ribbon Group.

17. From the Reports dialog, right press on Trees Report and select Preview results. 

18. Return back to the Landscape.dgnlib in the DGNLIB\EN directory. Create a copy of the Trees Report, rename it Shrubs Report, adjust the 
Item Types and Columns as needed. 
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Remember the report is sorted on Item No. and formatted to Upper Case for the Common Plant Name. 

19. Test the new report. 
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Creating Reports from Graphical Elements

The following section contains exercises to create a linear feature, a silt fence, drawn on a specific level in the main 
design file. That fence will then need to be quantified. A report will be created that will look for all lines on a specific 
level, then display its current level and its linear total distance. Next we run a report on DGN Elements, specifically a 
parcel boundary, and place a report on our sheet.

Note: The exercises contained in this workbook are designed to follow a specific workflow called LEARNing CONNECT. The 
workflow is set via the Workflow toolbar shown below. The purpose of the LEARNing CONNECT workflow is to simplify the menu 
choices for the new learner. However, you may also use the standard Drawing workflow. The location of the Ribbon Tabs, 
Ribbon Groups and Tools are identical for both workflows.

You will learn how to:

 Creating a Report

 Run a Report

 Adding Quantity, such as linear units of distance

 Place Table from Report

 Retain Association
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Reporting on a Linear Feature: Silt Fence

In this exercise you will create a linear feature, a silt fence, drawn on a specific level in the main design file. That fence 
will then need to be quantified. A report will be created that will look for all lines on a specific level, then display its 
current level and its total linear distance. 

 Create a Report

 Add a Quantity, such as linear units of distance

 Place Table 

 Retain Association

1. Start MicroStation, from WorkSets select the WorkSet called QuickStartforCONNECT, Pin the project to the List and pick Browse to view 
the files in the DGN directory. 

2. Open the design file LandscapeRD_8.dgn from the DGN project directory. Open the Default Model.

3. Select the Workflow, LEARNing CONNECT.

4. From the View Ribbon Tab, select Apply Saved View, from the Saved Views Ribbon Group.
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5. Select the Saved View Parking Lot and Landscape and apply it to the view.

Just to the east of the property line a 20 foot wide flower bed will be placed. This area will be tilled in preparation for placing the flowers. 
We need to mark where a Silt Fence will be placed just 5 feet from the edge of the flower bed. Set the Active Level to Silt Fence, and 
color, line style, and line weight to ByLevel.

6. From the Home Ribbon Tab, select Move Parallel from the Manipulate Ribbon Group.
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7. Set the Active Level to Silt Fence. Pick Copy Parallel and set the tool settings as shown. Copy the Plan Property Boundary 25 feet to the 
east (right) turning on Make Copy and Use Active Attributes.
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8. Next, extend the Silt Fence to intersect with the Back of Sidewalk (SidewalkBack_ep) using Trim to Element located in the Modify 
Ribbon Group on the Home Ribbon tab.

Now that we have placed our Silt Fence, let’s create a quantity report to be placed onto a sheet within the drawing, Fencing Summary.

9. From the Analyze Ribbon Tab, select Reports from the Reports Ribbon Group. From Reports pick New Category, call it Fencing and then 
pick New Report Definition. Name the New Report Definition, Silt Fence Construction. Set the Location Type to Model and the Location 
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to Specific File, LandscapeRD_8.dgn. Set the Model to Default. From Included Items set the Item Types to Include these Item Types, 
then expand DGN Elements and select Lines and pick OK.

Note: It is a best practice when creating Reports to create them in a configured Dgnlib. Also note the option for Include Reference 
Attachments and the Location either Active file or a Specific File.
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10. From the Filtered By option on Included Items, open the Condition Editor, pick Pick Property > Lines > General > Level, then set it to 
equal the level, Silt Fence as shown, selecting OK when complete. 
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11. Next expand the Silt Fence Construction report, selecting Column followed by Add columns, then expand Lines followed by General, 
checking Level, scrolling down expand Geometry followed by Segments , selecting Total Length, pick OK when complete.

12. Back on Reports, right press on Total Length under Columns, select Add formatting, change the Label Format to MU and the Accuracy 
to 0.12. Add a Suffix US Survey Feet, then insert a space. From Report pick Preview results.

13. Next lets change the Active Model to Fencing Summary. Now that we are in a separate model from where our geometry is (Silt Fence) our 
report is designed to look in the specific file, and not to include References. From the Home Ribbon Tab, set the Active Level to Table. 
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14. Then from the Reports dialog, select Place as table, setting the options as shown, specifically the 1/8in text and Retain Association, 
providing a data point to place the table just under the geometry of the sheet.
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Creating a Table

The following section contains exercises to place an empty table, and using the Table Tools, format the table as desired. 
The table fields will be filled out manually. A “Fencing Report” table will also be placed on a sheet, with the table values 
being populated using an existing fencing report, and the resulting table formatted.

You will learn how to:

 Place Table

 Set Rows and Columns

 Use Table Tools

 Merge Cells

 Add Fill

 Justify Text in Fields

 Set Title and Header 

 Place Report as Table
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Place and Format a Table for Plan Sheet

In this section an empty table will be placed and then, using the Table Tools, the table will be formatted as desired. The 
empty fields in the table will be filled in manually.

 Place Table

 Set Rows and Columns

 Use Table Tools

 Merge Cells

 Add Fill

 Justify Text in Fields

 Set Title and Header Row

(Completed table)
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Place Table, Empty Table lets you create a table, defining its rows and columns, formatting its look and using standard text tools, define 
the text. Tables can also be created and populated via Excel or CSV (Comma Separated Value Files). 

1. Start MicroStation, from WorkSets select the WorkSet called QuickStartforCONNECT, Pin the project to the List and pick Browse to view 
the files in the DGN directory. 

2. Open the design file LandscapeRD_6.dgn from the DGN project directory. Open the Model Planting Summary.
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3. Select the Workflow, LEARNing CONNECT.

4. Fit the View by double clicking the wheel mouse. Set the Active Level to Table. From the Annotation Ribbon Tab, pick Place Table from 
the Table Ribbon Group.

5. The table we need to place and fill out has 3 Columns with 6 Rows, including Title and Header. We can of course add more or remove any 
extras as needed. Set the Text Style as shown, and the rest of the options as shown. Place the table near the top of the sheet 
approximately centered in the sheet.
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6. Using Element Selection, select the newly placed table and note the context based ribbon tab Table Tools appear. This will allow the 
editing of the format of the table itself.

7. Start by selecting the top row, then from Table Tools, set this as the Title Row, and select the Merge Cells option. This will combine all 
three cells together and define this as our Title Row. Double click into this top Title Row, this will launch the Text Editor, set the Text Style 
to Header Row and type “TO BE CONSTRUCTED”. Set the Alignment to Center Justify and Align Center. Data point on the table to 
complete.

8. Next select the second row as shown, then set the option for Header Row. 
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9. Set the following and enter the data into each field as shown.
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Place Fence Report as a Table

In this exercise, we will place and format a Fencing Report on a sheet.

 Place Report as Table

 Table Tools

1. Continue in the design file LandscapeRD_6.dgn from the project directory, and open the Fence as Report Summary. 

2. From the Annotate Ribbon Tab, select Place Table from the Table Ribbon Group. Select the second option of From Report. Ensure the 
Seed is set to None and Annotation Scale is turned on and the rest of the options match as shown.
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3. Place the Fencing Report as shown on the sheet.
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4. Adjust using the Table Tools, using Element Selection to match in a similar way to below.
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